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1 ViewPorts Layout 
 

Once Viewports has been installed on the client machine, it can be launched from the Start 

Menu, by double clicking the desktop icon or by quick launching from the desktop Task Bar. 

Once Viewports is running, and the user has connected to cameras, they will see the layout 

shown below. There are 6 main areas in the layout: 

 

1.  Main Menu Toolbar ï Use these dropdown Menus to access the Tools and Advanced Sub 

Menus. 

2.  Navigation Pane ï This shows the available Servers and their corresponding Cameras. 

3.  Live Camera View ï This is where the live camera streams will display. 

4.  Icon Taskbar ï These are shortcuts to various Camera and Server functions. 

5.  Layout Taskbar ï Here the user can change the layout of the Live Cameras. 

6.  Timeline Pane ï This panel controls the Live Camera and Archive playback. 
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2 Connecting to a Server running Video Commander 
 

In order to begin streaming Live Camera data, the user must first connect to a server that is 

running Video Commander. Connecting to a live server will allow the user to connect to the 

cameras associated with that server. 

2.1 Connect to a Server 

 

There are 3 ways to connect to a server: 

 

1. From the Main Menu Toolbar, select Connection>Connect to Server. 

2. From the Icon Taskbar, select the óConnect to Serverô icon. 

3. Right click in the Navigation Pane and select óConnect to Serverô. 

 

Once one of these methods has been selected, the Connect to Server dialog box will appear: 

 

 
 

1. Type in a valid Hostname, either by name or IP address (depending on Server setup). 

2. Select a valid Port Number (80 by default). 

3. Type in a valid Username. 

4. Type in a valid Password for the Username. Note - óSave Login Credentialsô can be 

checked to avoid retyping the Username and Password. 

5. Select the Connect button. 

6. The Hostname or IP address entered will appear in the Navigation Pane to the left side of 

the screen. 

7. Select the Plus (+) sign next to the Hostname to view the available cameras on that 

server. 
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3 Connecting to Live Cameras 
 

Once a server connection has been established, the user can then connect to the available 

cameras on that server. 

3.1 Connect to a Single Camera 

 

There are 4 ways to connect to a camera: 

 

1. From the Main Menu Toolbar, select Connection>Connect to Camera. 

2. From the Icon Taskbar, select the óConnect to Cameraô icon. 

3. From the list of available cameras, right click on a camera and select óConnect to 

Cameraô. 

4. From the list of available cameras, left click and hold on a camera name and then drag 

that name into an available window. The camera will open. 

 

Unless the user has chosen to right click on a camera directly, or by dragging the camera into a 

window, they will receive a dialog box. 

From this dialog box, the user should select the Hostname of the server they wish to connect to. 

From this dialog box, the user should select the Camera they wish to connect to. 

Selecting OK will connect to the camera. 

3.2 Connect to all Cameras on a Server 

 

All cameras that are available will be opened in the order that they appear in the Navigation 

(Server) Pane. 

 

Select the server that has the cameras the user wishes to connect to. 

Perform a single right mouse click to display the Server sub menu. 

Select the Connect to all Cameras for this Server option (a username and password maybe 

required). 

3.3 Close a Single Camera 

 

Closing a camera will close the Live stream from the camera in question, but it will still remain 

available in the Navigation pane. There are 2 ways to close a single camera: 

 

1. Move the mouse over the selected camera and perform a single right mouse click and 

select the Close Camera option on the sub menu. 

2. Move the mouse over the selected camera and on the Live Camera Taskbar select the 

Close Camera button. 

3.4 Close all Cameras on a Server 

 

Select the server in the Navigation Pane that has the cameras the user wishes to close. 

Perform a single right mouse click to display the Server sub menu. 

Select the Close all Cameras option. 

All cameras that are associated with the server will be closed. 
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4 Viewports Live Camera View 
 

Once a server connection is established and the user has opened one or more Live Cameras, the 

Viewports layout will appear as below. Double clicking any window will make that view the 

main Camera. The Timeline Pane will be active and within the Camera View, the following 

information will be displayed: 

 

1.  Camera Name ï The name of the camera being displayed. 

2.  Live Camera Functions ï Allows the user to perform a number of functions. 

3.  Frame Rate and Resolution ï Shows the current frame rate and resolution of the 

camera. 

4.  Synch Indicator ï Means that the selected camera is in synch with the Timeline. 

5.  Time ï Shows current time on the camera. 

 

 
 

4.1 Live Camera View Sub Menu Functions 

 

By performing a single right mouse click on the currently selected Camera View the sub menu 

for that camera will appear. The available options are: 

4.1.1 Close ï Camera 

Selecting this option will close the selected camera. 

4.1.2 Close ï All Video 

This option will close all of the current open cameras and video clips that are open in Viewports. 

1 

2 

3 

4 
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4.1.3 Flip Image ï Vertical 

This option flips the currently displayed Live Camera view vertically. 

 

Before Flip Image Vertical Selection       After Flip Image Vertical Selection 

   

4.1.4 Flip Image ï Horizontal 

This option flips the currently displayed Live Camera view horizontally. 

 

Before Flip Image Horizontal Selection       After Flip Image Horizontal Selection 

   

4.1.5 Save Camera View 

This function will allow the user to save the currently selected view. Once the option is selected, 

a ñSave Camera Viewò dialog box will appear. 
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In the Save Camera View dialog box either accept the default name for the camera view, or 

change it to reflect the user preference. Should existing views already be present, the user can 

choose to replace an existing view. In this case, another dialog box will appear which asks to 

confirm if the user wishes to overwrite the existing view. 

4.1.6 Browse ï Camera Views 

This allows the user to browse through previously saved camera views. 

4.1.7 Browse ï Bookmarks 

This function allows the user to browse through previously saved bookmarks. See the Timeline 

Pane section for more detail. 

4.1.8 Guard Tour 

This function works along with the Guard Tour Interval setting from the óBehaviorô tab found 

under Viewport Settings. If this option is selected, Viewports will display and then switch to a 

different camera view in the main window, changing the view according to the time interval set 

by the user (default 5 seconds). 

4.1.9 Layout ï Set as preferred layout 

This option allows the user to set the currently selected Layout as their Preferred Layout. This 

will then become the default Layout every time the user runs Viewports. Please note that the 

current layout needs to be different from the layout that is specified in the ViewPorts Settings 

dialog box. This change will take effect once ViewPorts is closed and then reopened. 

4.1.10 Layout ï Switch to preferred layout 

This option will allow the user to instantly switch to the preferred layout that is specified in the 

ViewPorts Settings dialog box. Once selected, the layout changes to the setting specified in the 

ViewPorts settings dialog box. 

4.1.11 Layout ï Switch to Fullscreen 

When this option is selected, the Camera View switches to a Fullscreen view. Press any key to 

exit this mode. 

4.1.12 Download Archive 

The Download Archive function will allow the user to download an Archived clip based on Date 

and Time or download a group of Motion Detect files based on a range of time. Please see the 

Download Archive section for more details. 

4.1.13 Clip Options (only available during Clip playback) 

This option is not available unless the User is watching a clip, in which case it becomes Active. 

Please see the section Clips Playback for more information. 

4.1.14 Motion ï Enable Alarm 

This option will initialize the Motion Alarm alert. Please note that this function needs to be 

configured prior to use, please see the Motion Alarm main section for more details. 
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4.1.15 Motion ï Enable Alarm All 

This option will initialize the Motion Alarm alert on all active cameras. Please note that this 

function needs to be configured prior to use, please see the Motion Alarm main section for more 

details. 

4.1.16 Motion ï Disable Alarm All 

Selecting this option will disable the Motion Alarm alert on all active cameras. Please note that 

this function needs to be configured prior to use, please see the Motion Alarm main section for 

more details. 

4.1.17 Email ï Email Snapshot Quick 

Selecting this option will send an instant email to anyone listed as a contact. Please note that this 

function needs to be configured prior to use, please see the Email main section for more details. 

4.1.18 Email ï Email Snapshot 

Selecting this option brings up the send email configuration box which allows the user to change 

settings before sending the email. Here, the user can add or delete email contacts, add headers to 

emails and view snapshot properties. Please note that this function needs to be configured prior 

to use, please see the Email main section for more details. 

4.1.19 Email Clip Options (only available during Clip playback) 

These options are not available unless the User is watching a clip in which case they become 

active. Please see the Clips Playback section for more information. 

4.1.20 Configure Camera 

Selecting this option will open the ñConfigure Cameraò dialog box. Within this dialog box are 4 

Tabs that variously allow the User to make changes to the actual Camera itself, as well as a 

Factory button which restores the camera to its default settings. It is recommended that only an 

authorized Administrator make any changes under these settings. 
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4.1.20.1 Identification Tab 

 

 
 

Server Alias 

This field shows the alternative name for the Camera Server, if it has been renamed. 

 

Hostname 

Shows the actual Server name. 

 

Camera ID 

This field shows the camera serial number. 

 

Camera Model 

Displays the camera type and model number. 

 

Camera Name 

Shows the camera name, by default taken from the Camera ID, but can be renamed by the User. 

 

Status 

Shows the current status of the camera. 
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4.1.20.2 Camera Settings Tab 

 

 
 

Brightness 

Use the slider to set the desired Brightness of the camera. The default value is 1000 and pressing 

the Default button will return the Brightness slider to this value. 

 

Shutter Speed 

Shutter Speed is set to automatically adjust by default and it is recommended that it is left on this 

setting. The user can manually adjust the Shutter Speed should the conditions require. 

 

Gain 

Gain is set to automatically adjust by default and it is recommended that it is left on this setting. 

The user can manually adjust the Gain should the conditions require. 

 

Gamma 

Gamma is set to automatically adjust by default and it is recommended that it is left on this 

setting. The user can manually adjust the Gamma should the conditions require. 
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4.1.20.3 Video Attributes Tab 

 

 
 

Resolution 

This feature is not active in v1.13. 

 

Frame Rate (FPS) 

This feature is not active in v1.13. 

 

Compression Quality 

This field is not active in v1.13. 

 

Resolution Downsample 

This feature is disabled in v1.13. 

 

Frame Rate Downsample 

This feature is not active in v1.13. 

 

Flip Image Vertical 

Choose this setting to flip the camera image vertically for all users. This will affect all users who 

view the camera, rather than the local vertical flipping which happens within the Live Camera 

Sub Menu. 
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4.1.20.4 Motion Detector Tab 

 

 
 

Motion Alarm  

Checking this box enables the Motion Alarm on the Camera in question. 

 

Percent Change Detect Sensitivity 

Sets the sensitivity of individual pixel motion. A higher value means the Motion Alarm is less 

sensitive to Motion Detection.  

 

Temporal Detect Sensitivity 

Indicates how many frames in a row need to be detected to be considered Motion. A higher value 

means less Motion will be detected. 

 

Temporal Drop Sensitivity 

Indicates how many successive frames with no movement need to occur before the object is not 

considered for Motion detection. 

 

4.1.20.5 Factory Button 

Selecting this option will allow the user to set ViewPorts back to the original Factory default 

settings. 
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4.2 Live Camera View Taskbar 

 

Within the Live Camera View, there is a small taskbar that allows the user to perform certain 

functions: 

 

     
 

From left to right, t hese functions are: 

 

1. Close Video Window 

2. ROI 

3. Toggle Low/High Resolution 

4. Close ROI 

5. Synchronize to Timeline 

6. Email Snapshot 

7. Download Archive 

8. Record 

4.2.1 Close Video Window 

Selecting this option will close the selected camera. 

4.2.2 ROI 

The ROI (Region Of Interest) function allows the user to select a region within the Live Camera 

view for enhanced viewing. In the screenshot below, note the green square in the main window 

which indicates an ROI has been selected. 
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After selecting a region, the chosen ROI is opened in a new window with a zoomed view, 

allowing closer inspection of a specified area. The ROI is actually a cropped view of the High 

Resolution stream. As long as the ROI is active, the user can drag the region around in the main 

window and change the area being zoomed. Double clicking in the ROI will make it the main 

window as shown below. 

 

 
 

The ROI window has a taskbar with the same functionality as the main Live Camera viewer. The 

ROI window also has a Directional Wheel icon above the taskbar which can be used to move the 

region of interest around without having to reopen the original Live Camera from which the ROI 

was selected. 

4.2.2.1  ROI Direction Wheel Functionality 

 

The ROI Directional Wheel allows the user to move the ROI window left, right, up, down or 

zoom in and out as desired. 

 

 

 

 
 

 

 

 

Move Left 

Move Up 

Move Down 

Move Right 

Zoom In 

Zoom Out 
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4.2.2.2  Multiple ROI functionality 

 

ViewPorts has the capacity to stream 2 ROIôs from the same camera but to 2 different clients. 

For example, if 2 operators are looking at the same camera, they are each able to open a Region 

of Interest and have separate ROI functionality. 

 

4.2.3 Toggle Low/High Resolution Stream 

Pressing this button will toggle the Camera Window between a Low or a High Resolution 

stream. This setting needs to be enabled in the ViewPorts Settings Behavior tab prior to use. 

4.2.4 Close ROI 

When the user has an active ROI open and is viewing the main Live Camera window, this button 

can be used to close the ROI directly instead of reopening the ROI window and closing it from 

there. When this option is selected, the crosshair will change to a red óXô and once this is moved 

over the ROI square, the user can close the ROI window with a single mouse click. 

4.2.5 Synchronize to Timeline 

Use this button to synchronize the selected Live Camera feed to the Timeline. 

4.2.6 Email Snapshot 

Selecting this option brings up the send email configuration box which allows the user to change 

settings before sending an email. Here, the user can add or delete email contacts, add headers to 

emails and view snapshot properties. Please note that this function needs to be configured prior 

to use, please see the Email main section for more details. 

4.2.7 Download Archive 

The Download Archive function will allow the user to download an Archived clip based on Date 

and Time or download a group of Motion Detect files based on a range of time. Please see the 

Download Archive section for more details. 

4.2.8 Record 

This function allows the user to instantly record either a Low or High Resolution clip (depending 

on the resolution currently selected) of the Live Camera stream (also of the ROI) without 

performing an Archive Download. There is a time limit of 5 minutes for the record function. Any 

recordings in progress when this time limit is reached will be stopped by the system and 

automatically saved. 

 

To record a clip: 

 

Press the Record button once to start the recording. An icon will appear in the top right corner of 

the Camera view which indicates recording has begun.  

When you wish to stop the recording, press the record button once more. The Record icon will 

disappear and the user will receive a message stating that a Low or High Resolution clip has 

been made and saved. Navigate to the Clips Tab to locate the recording. 
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5 Main Menu Toolbar 
 

From the Main Menu toolbar, the user can select some Live Camera functions as well as a series 

of advanced configuration options. 

5.1 Connection 

Use this dropdown menu to connect to Servers and Cameras as well as browsing Views and 

Bookmarks. 

5.1.1 Connect to Server 

Use this option to connect to a Live server and the Connect to Server dialog box will appear. 

 

1. Type in a valid Hostname, either by name or IP address. 

2. Select a valid Port Number (80 by default). 

3. Type in a valid Username. 

4. Type in a valid Password for the Username. Note - óSave Login Credentialsô can be 

checked to avoid retyping the Username and Password. 

5. Select the Connect button. 

6. The Hostname or IP address entered will appear in the Navigation Pane to the left side of 

the screen. 

7. Select the Plus (+) sign next to the Hostname to view the available cameras on that 

server. 

5.1.2 Connect to Camera 

Selecting this option will open the Connect to Camera dialog box. 

From this dialog box, the user should select the Hostname of the server they wish to connect to. 

From this dialog box, the user should select the Camera they wish to connect to. 

Selecting OK will connect to the camera. 

5.1.3 Browse Camera Views 

This allows the user to browse through previously saved camera views. 

5.1.4 Browse Bookmarks 

This function allows the user to browse through previously saved bookmarks. See the Timeline 

Pane section for more detail. 

5.1.5 Goto Time 

Selecting this option will invoke a Calendar dialog box that the user can use to select a point in 

time from the Archives and then go directly to that Time. Any cameras synched to the Timeline 

will jump to that point. If the user enters a time that is prior to the Archives, they will receive an 

error message. See the Timeline Pane for more details.  

5.1.6 Download Archive 

The Download Archive function allows the user to download an Archived clip based on Date 

and Time or Download a group of Motion Detect files based on a range of time.  The user can 

specify the range of time for the download. Before downloading, make sure that there is enough 

disk space available for the download based on the Estimated Download Size. The Download 

will be placed in a default directory. 
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There are five ways to invoke the Download Archive dialog box: 

 

1. From the ViewPorts main screen, select; Connection>Download Archive. 

2. From the bottom left taskbar in the Server pane, select the Download Archive icon. 

3. From a live camera view select the Download Archive button from the Live Camera feed 

taskbar. 

4. Move the mouse over the camera being viewed and select a right mouse click and select 

the Download Archive option. 

5. From the Server Pane, select the camera to view by performing a single right mouse click 

and select the Download Archive option. 

 

Once the user has selected to Download an Archive, the Download Archive Dialog Box will 

show: 

 

 
 

 

1.  Archive Selection ï Select the Server Name, the camera the user wishes to download an 

archive from and the resolution of the clip. 

2.  Video Selection ï Choose an archive download based on Time or Motion. 

3.  Download Estimates ï Shows estimated download size and time. 

4.  Destination Clip Name ï Choose a name for the clip or leave as default. 

5.1.6.1  Time Query 

To execute a Time Query, first select a valid HostName from the HostName drop down box. 

This will need to be a Server that the user has connected to before. Next select a valid Camera 

from the Camera drop down box (the camera names will change based on the Server selected). 

Next select the Resolution. 1920x1080 is a High Resolution clip, whilst 640x360 is Low 

Resolution. Accept the default values for Start Time or change the values to a date and time 

frame that is requested. Make sure that the time frame is within the default time maximum of 

five minutes. 

In the Destination Clip Name accept the default value or change the value to a name that is more 

specific to what is captured in the clip.  The default clip name represents the server name, camera 

name, date and time. Select the OK button to submit the request for the download. An 

information box will appear with the text ñDownload Startedò. 

 

 

1 

2 

3 

4 
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In order to view the status of the Download, select Tools>Download Manager. The Download 

Manager box will appear with the status of each current download. For more information, see the 

Download Manager section. 

5.1.6.2 Motion Query 

To execute a Motion Query, first select a valid HostName from the HostName drop down box. 

The HostName has to be a Server that the user has been connected to before. Next select a valid 

Camera from the Camera drop down box (the camera names will change based on the Server 

selected). Next select the Resolution. 1920x1080 is a High Resolution clip, whilst 640x360 is a 

Low Resolution clip. Accept the default From, Date and Time or change the values to a date and 

time frame that is requested.  Make sure to keep the format for date and time consistent. 

Select the Query button and the Motion Archive Query for ñCamera Xò information box will 

show. 

From the list of clips, either select each clip individually by holding down the CTRL key and 

performing a single left mouse click or select all clips by performing a single mouse click on the 

first clip, selecting the Shift key and selecting the last clip with a single mouse click.  All of the 

clip should be highlighted. Now select the OK button (the Motion Archive Query box will close) 

On the Download Archive dialog box, select the OK button. An information box will appear 

with the text ñDownload Startedò. 

In order to view the status of the Download, select Tools>Download Manager. 

The Download Manager box will appear with the status of each current download. For more 

information, see the Download Manager section. 

5.1.7 Close All Cameras and Clips 

Selecting this option will close all active Cameras and Clips. 

5.1.8 Exit Viewports 

Selecting this option will close the Viewports application. Then select the OK button on the Exit 

dialog box to confirm. 

 

5.2 View  

5.2.1 Dock ROIs 

This option is only available when the User is in Freeform Settings and is used to align the open 

ROIôs to the bottom of the screen to enable the User better control if the Viewing area. See the 

Layout Taskbar section for more information. 

5.2.2 Lock positions in Layout 

Use this option to fix the Live Camera windows in place. The windows will stay locked (even 

after an application reboot) in position until such time as the user un checks the option. 

5.2.3 Guard Tour 

This feature allows the user to have a camera display for a set time in the Main Window before 

switching to the next camera in the array. For example, if the user has 10 Cameras they wish to 

watch, they can enable the Guard Tour feature and this will switch the Main Window to each 

camera in turn according to the time interval set in the Behavior Tab under ViewPort Settings. 
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5.2.4 Show Navigation Pane 

Checking or un checking this option will show or hide the Navigation Pane as appropriate. 

Hiding the Navigation Pane will allow the system to use more of the available screen space thus 

making the camera view or clips appear larger. 

5.2.5 Show Freeform Settings Toolbar 

This function will allow the Freeform settings dialog box to show.  This option is only available 

when the current ViewPorts layout is Freeform. 

5.2.6 Show Timeline Pane 

Checking or un checking this option will show or hide the Timeline Pane as appropriate. 

5.2.7 Show Controls and Overlays 

Checking or un checking this option will show or hide the Live Camera controls and information 

as appropriate. 

5.2.8 Font Size 

This function allows the user to specify the size of the font that displays the camera name, frames 

per second, resolution and time. The default font size is 10. Pressing the Factory button will reset 

the Font Size to the default value. 

 

 

5.3 Tools 

5.3.1 Viewport Settings 

Selecting this option allows the user to change a multitude of settings. Any changes made are 

independent to the clients machine. Once selected, a dialog box will appear that has 10 Tabs and 

a Factory reset button: 
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5.3.1.1 Appearance Tab 

 

 
 

Show Tooltips 

This function allows the user to select whether Tooltips are displayed or not. 

 

Show Overlay only in Current Window 

When this option is selected, information such as the Camera Name and the Toolbar will only 

show to the user when the mouse icon is held over the active window. 

 

Show Resolution/FPS in Overlay 

When either of these options are selected, the resolution and/or FPS information will be 

displayed in the active window. 

 

Background 

This option allows the user to choose whether they have No background in ViewPorts (may 

improve performance on slower machines), an Embossed background or a Color background.  
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5.3.1.2 Behavior Tab 

 

 
 

Layout 

Choose a Preferred Layout from the dropdown menu. The default is 1x5. 

 

Guard Tour Interval  

Choose the Interval time between Camera feed switches when the user has selected Guard Tour. 

Default is 5 seconds. 

 

Lock Video Windows 

When this option is checked, the Live Camera windows will remain fixed in the positions they 

were in when the option was checked. 

 

High Resolution Streaming 

Select this option to enable High Resolution video streaming and to decide the behavior of the 

High Resolution Stream: 

 

Disabled ï High Resolution Streaming is not available 

Manual ï The user can choose when to switch to a High Res stream in the Live Camera 

Auto ï Selecting this option means that when the Live Camera window is a certain size, the 

stream will automatically switch to High Resolution. 
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5.3.1.3 ROI Tab 

 

 
 

High Res ROI Render 

Choose to have the ROI auto resize to fit the window it is being viewed in (Best Fit To Window 

Size) or keep a smaller ROI, but of a higher quality (Best Image Quality). 

 

Slave IRIS to ROI 

This option changes the Brightness Level of the view according to the Brightness of the ROI 

region. 

 

Max Number of Freeform ROI 

Choose the maximum number of ROIôs the user can have open when they are in Freeform mode, 

from 1 to 7. The default number is 3. 
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5.3.1.4 Archive Query Tab 

 

 
 

Request Low Res By Default 

This option will change the setting within the Download Archive function to default to the Low 

Resolution option when a Download Archive is requested.  This option can be overwritten in the 

Download Archive dialog box. 

Request Motion By Default 

This option will change the setting within the Download Archive function to default to the 

Motion Query option when a Download Archive is requested.  This option can be overwritten in 

the Download Archive dialog box. 

Download Speed 

This option allows the user to choose a download speed from the following options : 

Slow, Normal, Fast and Maximum 

Time Query 

This option will set the default value in the Download Archive dialog box for the TimeSpan in 

seconds.  Once in the Download Archive dialog box, this value can be overwritten for the 

download requested. 

Motion Query 

The options within this section will allow the user to specify the default request time span in 

hours and minutes for the motion detect files as well as the maximum number of motion 

detection files that the system will gather and download to the local client. 

 



 

ViewPorts User Manual v1.13  28 

5.3.1.5 Server Connect Tab 

 

 
 

Connection Timeout 

This option will tell the system how long to wait before the camera connection will timeout. 

For example if the hostname is disconnected from the network, the client will wait the amount of 

time selected in this field before it closes out the camera views for that host. 

 

ROI Connection Timeout 

This option will tell the system how long to wait before the ROI connection will timeout. 

For example, if a ROI is selected and there is a disconnect from the network, or if the Frames Per 

Second reaches a value of zero (0) for this duration, the ROI will close automatically. 

 

Video Smoothing Delay 

This option helps to compensate for lag time between the client and server machines by 

buffering the video stream. The default time is 500 msec (1/2 second) and can be set to 0 msec 

(no buffer) up to 3000 msec (3 second buffer). 
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5.3.1.6 Timeline Tab 

 

 
 

Max Number of Days in Timeline 

Choose how many days of history to show in the Timeline Pane.  
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5.3.1.7 Local Recording Tab 

 

 
 

Maximum Clip Length  

This option sets the timeout feature for the Clip Recording function in minutes.  In the event that 

a clip is set to record and the user steps away from their machine or switches to another window, 

the system will use this default setting to stop the Clip Recording function. As well, this setting 

sets the limit for the amount of time that can be recorded in minutes. 

 

Min Disk Available 

This option sets the amount of disk space available locally for clip recording.   
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5.3.1.8 Motion Alarm Tab 

 

 
 

Highlight Motion (RGB)  

This option allows the User to change the color of the barrier around an object that is recognized 

by the system if the Motion Alarm option is selected 

 

Play Sound Alarm 

Selecting this setting means that a Sound Alarm will play if Motion is detected in a Camera 

View. If this box is unchecked, no alarm will sound.   

 

Sound Alarm Settings 

Under this setting, the User can choose to use the default Sound Alarm ñCamera X:Motion 

Detected!ò or they can select a different Wav file to alert them if motion is detected. 

 

Duration 

Under this setting, the user can choose either to play the selected Sound Alarm in a loop which 

means the sound will play continuously while the object stays within the camera view or to just 

play the sound file once when the object enters the camera view. 

 

Volume 

Adjust the volume of the Sound Alarm according to the Users needs. 

 

Test Sound 

This will play the selected Sound Alarm. 
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5.3.1.9 Email Tab 

 

 
 

Email Clip in WMV For mat 

Choose this setting to send email clips in the WMV format. This is the default and is the 

recommended setting. 

 

Configure Email 

This opens the Configure Email dialog box. See the Configure Email section for more 

information. 
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5.3.1.10 Service Tab 

This Tab should only be accessed by authorized Administrators or Pixel Velocity Engineers as it 

contains settings which could have an adverse effect on Client and/or Server machine 

performance. 

5.3.1.11 Factory Button 

Use this button to restore Viewports to its factory default settings. Pressing this button will 

discard any changes the user has made. 

 

5.3.2 Download Manager 

The Download Manager information window will allow a user to view the currently requested 

downloads. In this information window the user can get a constant status on the download by 

percent as well as a final status for completion/failure/cancelled. 

 

There are two ways to open the Download Manager information window: 

 

1. From the ViewPorts Main screen, select Tools>Download Manager 

2. On the Navigation Pane when the Clips tab is selected, select an available folder and 

perform a single right mouse click 

 

 
 

The Available fields for view on the Download Manager Information window are: 

 

1.  Filename ï The filename that the clip is named 

2.  HostName ï The Server that the archive is from. 

3.  CameraName ï The name of the Camera that captured the video 

4.  Resolution ï The level of detail that the image holds : 

1920x1080 ï This is a High Resolution Clip 

640x360 ï This is a Low Resolution Clip 

5.  StartTime ï The start time of the video 

6.  EndTime ï The end time of the video as calculated by the TimeSpan from the High 

Resolution Archive dialog box 

7.  SizeMB ï The size of the video as calculated in the High Resolution Archive dialog box 

8.  PercentDownloaded ï The amount of the download completed 

 

1 2 3 4 5 6 7 8 9 
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9.  Status ï A status of the download.  Available status are: 

In Progress ï A download that is in progress (no color highlight) 

Done - Complete ï A download has finished without error (highlighted in green) 

Done - Failed ï A download that has failed (highlighted in red) 

Done - Partial ï A download that has completed successfully, but is a partial download 

(highlighted in yellow) 

Canceled ï A download that was canceled by the user (highlighted in red) 

For each of the messages that are a part of the status field, an information box will show 

on the screen once the application has a done status. 

10.  Cancel (button) ï This function will cancel the selected download that is in progress. A 

download needs to be in progress for this function to be available 

11.  Retry (button) ï This function will allow the user to retry a failed or canceled download 

archive request without having to go through the Download Archive dialog box. A 

download archive will need to have been attempted for this function to be available and 

should have a status of either óFailedô or óDone ï Partialô. It is possible to highlight 

several downloads at once by selecting the CTRL key. 

12.  Delete (button) ï This function will allow the user to delete the clip from view in the 

Download Manager.  Deleting the clip from the view does not delete the clip from the 

system.  A download that is In Progress cannot be deleted, it must be canceled first. 

13.  Show Activity Filter  ï This allows the user to filter out older Downloads from the 

Manager should they wish to only see recent Downloads. 

14.  Show In Progress ïThis option will allow the user to specify that downloads that have a 

status of In Progress will be shown in the view.  If the option is not selected, the clips 

with a status of In Progress will not show. 

15.  Show Successful ï This option will allow the user to specify that downloads that have a 

status of Successful will be shown in the view.  If the option is not selected, the clips with 

a status of Successful will not show. 

16.  Show Failed ï This option will allow the user to specify that downloads that have a 

status of Successful will be shown in the view.  If the option is not selected, the clips with 

a status of Successful will not show. 

17.  Close (button) ï Selecting this option will close the Download Manager Information 

window. 

5.3.3 Browse Archives 

Selecting this option links to the users Documents and Settings folder on their C drive so that 

they can browse through the saved Archives stored locally on their machine. They are displayed 

in the same way as the Clips Tab. The user can play back any of the local archive clips using a 

suitable media player. 

5.3.4 Camera Pointing 

This option allows the user to ñmoveò the field of the view. However, it is not recommended that 

anyone except the Administrator of the system uses this function. 

5.3.5 Factory 

Selecting this option will allow the user to set ViewPorts back to the original Factory default 

settings. 
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5.4 Help 

5.4.1 Show Shortcut Keys 

Shows a dialog box with a list of Shortcut Keys. 

5.4.2 User Manual 

Selecting this option displays the current version of the User Manual. 

5.4.3 Administrator Manual 

Selecting this option displays the current version of the Administrator Manual. 

5.4.4 About Viewports 

Selecting this option displays information about Viewports such as the version number of the 

software. 

 

6 Navigation Pane 
 

The Navigation Pane displays a list of all servers the user has connected to in this session, or 

previous sessions, regardless of whether the Server is currently live or not. It also displays a list 

of Saved Views and Clips, depending on which tab the user has selected. 

 

There are two ways to show or hide the Navigation Pane: 

 

1. On the ViewPorts main screen select: View>Navigation Pane. If there is a check mark on 

the option Navigation Pane, the Navigation Pane is showing. If there is not a checkmark 

next to the option Navigation Pane, the Navigation Pane is hidden. 

 

2. In the Layout Taskbar, select the Show/Hide Navigation Pane icon. 

 

Navigation Pane Showing    Navigation Pane Hidden 
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6.1 Cameras Tab 

 

The Cameras Tab is the section within ViewPorts that contains the information for the available 

Servers/Host and the Cameras that are connected to them. By placing the mouse in a blank area 

of the Cameras Tab and right clicking, a sub menu will show with the following options: 

 

Connect to Server ï For information regarding this function see the Connect to a Server section 

of this manual. 

Connect to Camera ï For information regarding this function see the Connect to a Camera 

section of this manual. 

Hide Navigation Pane ï Information on this function is detailed earlier in this section of the 

manual. 

 

6.2 Views Tab 

 

The Views Tab is the location where the user specified Views are listed. Selecting a previously 

saved View will open the associated view with the cameras. For information regarding how to 

save a camera view, see the section Save Camera View. By placing the mouse in a blank area of 

the Views Tab and right clicking, a sub menu will show with the following options: 

 

Browse Camera Views ï This allows the user to browse through previously saved camera 

views. 

Hide Navigation Pane ï Information on this function is detailed earlier in this section of the 

manual. 

 

6.3 Clips Tab 

 

The Clips Tab is the location where the users stored clips are kept. The Clips Tab also shows the 

requested clips that were downloaded from the server, as well as locally recorded clips from the 

ViewPorts application. 

Downloaded clips are stored in the Local Archives main folder with recently downloaded clips 

stored in the óIncomingô folder and older clips stored in the óLegacyô folder. Each of these 

folders can be opened with the + sign to show the individual folders ordered by Date. By default 

a requested download is placed in a sub folder with the name referring to the current day.  

Downloaded clips can then be ñdragged and droppedò into a user created folders. Creating the 

folders within ViewPorts also creates folders within C:>My Documents>Viewports>Local 

Archives where the Video Clips are maintained. 

6.3.1 Clips Tab Sub Menu 

Right clicking in the Clips Tab brings up a Sub Menu of options. There are different options 

available depending on whether the user right clicks within the Tab, on the Folder containing the 

Clip or on the actual Clip itself. 

6.3.1.1 New Folder 

Right click in the Clips Tab or on a Clip Folder. Selecting this option will allow the user to create 

a new folder under each particular clip type. 
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6.3.1.2 Delete Folder 

Right click on a Clip Folder in the Clips Tab and select Delete Folder. On the confirmation 

window ñDelete folder ñ<folder name> and all itôs contents?ò, select the OK button. The 

selected folder is deleted. Once this folder is deleted, all sub folders within this folder will also 

be deleted. This function is not reversible. 

6.3.1.3 Play Clip 

Right click on a Clip within the Clips Tab. Selecting this option will begin playback of the 

selected clip in the next available window. See the Clips Playback section for more details. 

6.3.1.4 Email Clip 

Right click on a Clip within the Clips Tab. This will email the selected clip. See the Email 

section for more information. 

6.3.1.5 Delete Clip 

Right click on a Clip within the Clips Tab. This function will delete the selected video clip from 

the Clips Tab and from the local hard drive. Please note that this function is not reversible. 

6.3.1.6 Download Manager 

Right click in the Clips Tab. Selecting this option will open the Download Manager Information 

window.  For detailed information surrounding the Download Manager function, see the 

Download Manager section of this document. 

6.3.1.7 Browse Archives 

Right click in the Clips Tab to browse the Clip Archives. 

6.3.1.8 Export Clip 

Right click on a Clip within the Clips Tab. This function will export a selected video clip from 

ViewPorts in order that it may then be exported to an available portable media source. The video 

clips are structured to be viewed on another client that is running ViewPorts, but the video clips 

can also be viewed by a 3
rd

 party media player like Windows Media Player. 

Video sources can include - A partitioned hard drive on the existing client machine, a USB 

attached portable drive or a CD-R/RW. ViewPorts will create a default directory structure for the 

files on the media. 

6.3.1.9 Import Clip to Folder 

Right click in the Clips Tab or on a Clip Folder in the Clips Tab. This function will import a 

single clip that has been copied onto an available media source.  Video sources can include - A 

partitioned hard drive on the existing client machine, a USB attached portable drive or a CD-

R/RW. Please note that the Import function assumes that the video files that are being imported 

are in a directory structure and format that fits the ViewPorts application. 

6.3.1.10 Import Clips to Folder 

Right click in the Clips Tab or on a Clip Folder. This function will import all of the Video clip 

files that have been copied onto an available media source.  Video sources can include - A 

partitioned hard drive on the existing client machine, a USB attached portable drive or a CD-

R/RW. Please note that the Import function assumes that the video files that are being imported 

are in a directory structure and format that fits the ViewPorts application. 
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6.3.1.11 Export Clips from Folder 

Right click in the Clips Tab or on a Clip Folder. This function will export an entire folder of 

Clips to the location of the Users choice. 

6.3.1.12 Hide Navigation Pane 

Right click in the Clips Tab. Selecting this option will allow the user to hide the Navigation Pane 

from the display as detailed earlier in the manual. 

6.3.1.13 Folder Properties 

Right click on a Clips Folder in the Clips Tab. Selecting this option will open a properties 

information window for the selected folder. The user can change the name of the folder should 

they wish. 

6.3.1.14 Clip Properties 

Right click on a Clip in the Clips Tab to bring up detailed information regarding the video clip 

selected. However, there is only one field that is editable and that is the Clip Name. 

 

 
 

In descending order, the Clip Properties fields are: 

 

1. Clip Name ï By default the application will assign a name to the video clip that contains 

the hostname, camera name, date and time of the capture. 

2. Comments ï The user can add a comment or note relating to the clip in this field 

3. Hostname ï This is the name of the server that the clip was downloaded from. 

4. Camera ï This is the name of the camera that captured the video clip. 

5. CameraID ï This is the Manufacturing Camera Identification value. 
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6. Start Time ï This is the value that was specified in the Download Archive dialog box for 

this video clip. 

7. End Time ï This is a calculated value that is a product of the Start Time and TimeSpan 

specified in the Download Archive dialog box. 

8. Frame Rate ï This is the Frame Rate that is specified for each particular camera in the 

Camera Settings dialog box. 

9. Number of Frames ï This is the total number of frames that exist for the clip file. 

10. Compression Quality (1-99) ï This is the JPG Quality that is specified for each 

particular camera in the Camera Settings dialog box. 

11. Resolution ï This is the Resolution that is specified for each particular camera in the 

Camera Settings dialog box. 

12. File Size ï This is the actual size of the clip file. 

13. Digital Signature ï This field indicates whether a clip has a digital signature and 

subsequently whether it can be authenticated. See the Clip Authentication section for 

more details. 

6.3.2 Clips Playback 

To playback a clip, drag and drop it into an available window as you would a camera view. The 

clip will then begin to play back immediately. The user can also change the Layout of clips being 

played as well as open an ROI. Also, by performing a single right mouse click on an actively 

viewed clip, the sub menu for the clip will appear. The options available will be the same as if 

the user were viewing a Live Camera, except the óClipô option will no longer be grayed out and 

further Email options will be available. 

6.3.2.1 Scrub Bar 

During Clip playback, the scrub bar will appear in the bottom right corner of the window. The 

scrub bar shows the progress of the camera/video clip playback.  As well, the scrub bar shows 

the speed of the playback if it is sped up or slowed down. 
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6.3.2.2 Close Clip 

Selecting this option will close the currently viewed Clip. 

6.3.2.3 Create Sub-Clip 

Once this option is selected, the óCreate Sub Clipô dialog box will open. This enables the user to 

create a smaller clip from within a main Clip. The dialog box is independent of the clip playback 

controls. Once the user has started to playback a clip they can choose to óSet Timeô once to set a 

Sub Clip start point and then óSet Timeô once more to set a Sub Clip end point. This will give the 

User an indication of the Clip time and size. The user can hit the óClear Timesô button to reset 

the Start and End points should they wish. Once the user is happy with the Sub Clip, they can 

press the Create Clip button which then creates a new clip in a Sub Clip folder under the original 

Clip folder. 

6.3.2.4 Export Clip 

This function will export a selected video clip from ViewPorts in order that it may then be 

exported to an available portable media source. The video clips are structured to be viewed on 

another client that is running ViewPorts, but the video clips can also be viewed by a 3
rd

 party 

media player like Windows Media Player. 

Video sources can include - A partitioned hard drive on the existing client machine, a USB 

attached portable drive or a CD-R/RW. ViewPorts will create a default directory structure for the 

files on the media. 

6.3.2.5 Email Clip Quick 

This will email the selected clip without further configuration. See the Email section for more 

information. 

6.3.2.6 Email Clip 

This will open the email dialog box in order that the Sender can change details about the Email 

such as the Email title before sending. See the Email section for more information. 

6.3.2.7 Clip Properties 

This will bring up information about the Clip as detailed in the Clip Properties section of the 

manual. 

 

6.3.3 Clip Authentication 

Before a clip can be authenticated, it has to be downloaded directly from the server using the 

Download Archive feature. You cannot authenticate a clip recorded locally on the client 

machine. It is advisable that authentication of clips be performed by an Administrator, and as 

such, more details on this feature can be found in the Administrators manual. 
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7 Icon Taskbar 
 

The Icon Taskbar provides shortcuts to various Server and Camera functions, depending on 

which Tab is currently selected by the User. 

7.1 Cameras Tab 

7.1.1 Connect To Server 

Use this option to connect to a Live server and the Connect to Server dialog box will appear. 

1. Type in a valid Hostname, either by name or IP address. 

2. Select a valid Port Number (80 by default). 

3. Type in a valid Username. 

4. Type in a valid Password for the Username. Note - óSave Login Credentialsô can be 

checked to avoid retyping the Username and Password. 

5. Select the Connect button. 

6. The Hostname or IP address entered will appear in the Navigation Pane to the left side of 

the screen. 

7. Select the Plus (+) sign next to the Hostname to view the available cameras on that 

server. 

7.1.2 Update Server 

When there has been a change to the host Server, such as an extra Camera added to the array, or 

a Server name change, use this function to fetch the Update locally. Please note that the user will 

receive a confirmation message whether there has been an actual Server change or not. 

7.1.3 Connect To Camera 

Selecting this option will open the Connect to Camera dialog box. 

From this dialog box, the user should select the Hostname of the server they wish to connect to. 

From this dialog box, the user should select the Camera they wish to connect to. 

Selecting OK will connect to the camera. 

7.1.4 Download Archive 

Selecting this option will invoke the Download Archive functionality. See the Download 

Archive section for more details. 

7.1.5 Configure Server 

This will allow the User to make changes to the host Server such as a name change or adding 

new Users to the system. It is not recommended that this feature is invoked by anyone other than 

an authorized system Administrator. 

7.1.6 Configure Camera 

Selecting this option will open the Configure Camera dialog box. 

7.1.7 Remove Server 

Selecting this option will remove the selected Server from the local Navigation Pane list. Should 

this be an active server, the user will need to reconnect to the Server in order to view Cameras. 
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7.2 Views Tab 

7.2.1 Browse Camera Views 

This allows the user to browse through previously saved camera views. 

7.2.2 Camera View Properties 

This will show details about the selected View such as the View Name and the names of the 

Cameras that form the View. 

7.2.3 Delete Camera View 

This will remove the selected View from the list of saved Camera Views. 

 

7.3 Clips Tab 

7.3.1 Clip Properties 

This will bring up information about the Clip as detailed in the Clip Properties section of the 

manual. 

7.3.2 Delete Clip 

This function will delete the selected video clip from the Clips Tab and from the local hard drive. 

Please note that this function is not reversible. 

7.3.3 Email Clip 

This will open the email dialog box in order that the Sender can change details about the Email 

such as the Email title before sending it. See the Email section for more information. 

 

8 Layout Taskbar 
The Layout Taskbar is where the user can change the Layout of the Live Camera Windows on 

their local Client machine. This section will also explain how to change the Layout to a default 

value that will be seen by the user every time they start the ViewPorts application. 

 

8.1  Show/Hide Controls 

There are a number of buttons that can show or hide various features within ViewPorts. 

8.1.1 Hide Navigation Pane 

Selecting this button will hide the Navigation Pane. Pressing the button once again will show the 

Navigation Pane. 

8.1.2 Hide Timeline Pane 

Selecting this button will hide the Timeline Pane. Pressing the button once more will show the 

Timeline Pane. 

8.1.3 Show/Hide Overlays and Controls 

Selecting this button will show or hide the Live Camera controls and information as appropriate. 
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8.1.4 Best Fit Layout 

Selecting this button will change the size of the Live Camera windows so that they best fit the 

Layout selected by the user.  

 

8.2 Selecting Layouts 

ViewPorts Layouts can be set for Single or Dual Monitors depending on the users system setup. 

8.2.1  Enable Layouts 

There are two ways to change the current ViewPorts layout: 

1. On the ViewPorts main screen, select Views>Layout>then select a layout. 

2. On the right side of the screen, from the Layout Taskbar, select the layout that is 

required. 

8.2.1.1 Single Monitor 

Selecting this button will show only Single Monitor Layouts. 

8.2.1.2 Dual Monitor 

Selecting this button will show only Dual Monitor Layouts. 

8.2.2 Freeform Layout 

The Freeform Layout is a layout function that allows the user to move (via drag and drop) the 

Live Cameras around the screen and place them wherever they wish. Once the user presses the 

Freeform button, a settings dialog box will appear. There are several functions that are only 

available within the Freeform Settings box. Please note that the Freeform Settings dialog box can 

be closed independently of the ViewPorts application by selecting the ñXò in the upper right 

corner of the Freeform Settings dialog box. 

 

 

8.2.2.1 Image Size 

This slider adjusts the size of the Cameras in Freeform mode from a small size (Min) to a large 

size (Max). It maybe that not all Live Cameras are visible when the user has selected the Max 

size. 

8.2.2.2 ROI Size 

This slider adjusts the size of the ROIôs in Freeform mode from a small size (Min) to a large size 

(Max). It maybe that not all ROIôs are visible when the user has selected the Max size. 
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8.2.2.3 Snap to 

This function will allow the user to stitch Camera Views together to make a panoramic view. 

When the user drags Live Cameras together they can decide whether they snap together from a 

left to right perspective or whether they snap together from the top or bottom. 

To snap Live Camera views together: 

Select the Freeform Camera view and in the Snap to section place a check mark in the Left-Right 

and/or Top-Bottom options. Then select at least 2 camera views : 

 

  
 

Drag one of the camera views so that it is close to another camera view. They will snap together 

and the Views will look as though they are one: 

 

 
 

The user now has a stitched Camera View and can open an ROI in one window and drag it 

across the stitched Cameras and the view will behave as if it was one Camera. 

8.2.2.4 Dock ROIs 

If the user has a number of ROIs open at various points around the screen, pressing this button 

will dock the ROIs to the bottom of the screen enabling the user to order them more easily. 

8.2.3 Available Layouts 

There are a number of different ways to organize the Live Camera Views. 

8.2.3.1 1xN (Single Monitor Layout) 

The 1xN layouts will allow the user to view 1 large view of a camera and a number of smaller 

views of cameras. Whilst the larger camera views will have the optimal Frames Per Second 

(FPS) available, the remaining views will take into account the amount of CPU available on the 

machine and limit the FPS of the camera views. For example if the FPS for each camera is 10 

and the layout is 1x5, the larger camera view will show 10 FPS while the remaining camera 

views may show 5 FPS depending on the client CPU. 
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1xN View Examples: 

 

1x5 Layout                  1x7 Layout           1x9 Layout 

   
 

1x11 Layout                  1x13 Layout           1x15 Layout 

       
 

8.2.3.2 MxN (Single Monitor Layout) 

The MxN layouts will allow the user to view the cameras in equal size windows. Since each 

window is of equal size the amount of Frames Per Second (FPS) is split equally depending on 

the amount of CPU available on the client. For example if the layout is 2x2 and there is only one 

camera opened with a maximum default value of 10 for FPS, the camera will show up to 10 FPS.  

If three more cameras are added, each of the cameras will show a value of about 10 FPS. 

 

MxN View Examples: 

 

2x2 Layout        

 
 

3x3 Layout    4x4 Layout  
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8.2.3.3 1xMxN (Dual Monitor Layout) 

The 1xMxN Layouts are designed to be viewed across Dual Monitors that are joined together. 

8.2.3.4 2xNx1 (Dual Monitor Layout) 

The 2xNx1 Layouts are designed to be viewed across Dual Monitors that are joined together. 

 

9 Timeline Pane 
 

The Timeline Pane is a feature in Viewports that allows the user to control the Live Camera feed, 

and to quickly jump between Live footage and Archive video. The user has full control of the 

Live feed and can Pause, Rewind or Fast Forward one or more cameras simultaneously in real 

time as required. The Timeline Pane also gives the user an overview (in days) of all the archived 

material currently available for viewing on the Camera Server.  

 

 
 

There are 2 sets of User Controls within the Timeline Pane. The Left Control Panel is used for 

Book Marking and Synchronizing the Timeline, whilst the Timeline Playback Toolbar (Right 

Control Panel) is used for Pausing, Rewinding or Fast Forwarding the Live Feed.  

9.1  Timeline Pane Left Control Panel 

 

 
 

From left to right, the controls are: 

9.1.1  Sync All 

Pressing this button will synchronize all active Cameras to the time currently selected on the 

Timeline. For instance, the user may have 3 or 4 cameras all displaying different times and this is 

a quick way to synchronize them all to the same time. 

9.1.2 Goto Previous Bookmark 

If the user has a number of active Bookmarks on the Timeline, pressing this button will jump the 

Timeline (and all Synchronized cameras) to the previous Bookmark before the current time. 

9.1.3 Create Bookmark 

This feature allows the user to create a bookmark on the Timeline for future reference which they 

can then jump to instantly. Creating a bookmark opens a dialog box which allows the user to 

assign a unique name to the bookmark (or leave as default) and will also display information 

about which cameras will be saved. 
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9.1.4 Goto Next Bookmark 

If the user has a number of active Bookmarks on the Timeline, pressing this button will jump the 

Timeline (and all Synchronized cameras) to the next Bookmark after the current time. 

9.1.5 Browse Bookmarks 

Selecting this option opens a dialog box from which the user can browse their saved bookmarks. 

Select a bookmark and then hit OK to jump to that bookmark (if still available on the active 

Timeline).  

 

 

9.1.5.1 Properties 

Shows the properties of the selected bookmark. 

9.1.5.2 Delete 

Deletes the selected bookmark. 

9.1.5.3 Goto 

Goes to the selected bookmark (if still available). 

9.1.5.4 Goto/View 

Goes to the selected bookmark (if still available), but also changes the Layout of the Live 

Camera windows to match the bookmark. 

9.1.6  Timeline Download Archives 

Selecting this option opens a dialog box which allows the user to download selected Archive 

Clips. 
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9.1.7  Timeline Record 

Pressing the Record button in this Control Panel starts recording all Synched Cameras. Pressing 

Record again stops recording and saves the clip. 

9.1.8  Mark for Archive Download 

Pressing this button allows the user to specify a Start and End time for an Archive Download. 

Press the button once to choose the Start point and press the button again to select the End point. 

9.1.9  Goto Time 

Selecting this option brings up a Calendar from which the user can jump to a specific time on the 

Timeline (if available). 

 

9.2  Timeline Playback Toolbar (Right Control Panel) 

 

 
 

Use the Playback Toolbar to take control of the Live video feed. The functions within the 

Playback Toolbar work in a similar way to any standard home Video Recorder. From left to 

right, the controls are: 

9.2.1  Rewind 

Pressing this button will rewind the Live Camera feed back to the beginning of the Archives 

(indicated by the cross hatches on the Timeline). 

9.2.2  Play Reverse 

Pressing this button will start to play the Live Camera feed backwards. 

9.2.3  Step Back 

This button is only active when the Live Camera feed is paused. Selecting this function will play 

the video backwards frame by frame. For instance, if the video was captured at a frame rate of 10 

FPS, then the user will have to select the step back button 10 times for each second of time.  

Selecting this button one mouse click at a time will move the video back one frame at a time.  

Selecting this button with the mouse and holding down the mouse key will play the video 

backwards as though the play reverse button is selected. 

9.2.4  Pause 

Pressing this button will Pause the Live Camera or Video being played. 

9.2.5  Step Forward 

This button is only active when the Live Camera feed is paused. Selecting this function will step 

the video forwards frame by frame. For instance, if the video was captured at a frame rate of 10 

FPS, then the user will have to select the step forward button 10 times for each second of time.  

Selecting this button one mouse click at a time will move the video forward one frame at a time.  

Selecting this button with the mouse and holding down the mouse key will step the video 

forwards as though the fast forward button has been selected. 
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9.2.6  Play 

Selecting this function will resume playback of the Live Camera or Video Clip after it has been 

stopped or paused. 

9.2.7  Live Camera 

Pressing this button will return all synched cameras to the Live feed.  

9.2.8  Play Slower 

Selecting this button will play back the Live Camera feed or Video Clip at a slower speed in 

increments. 

9.2.9  Play At Normal Speed 

This button will return the playback speed to Normal. 

9.2.10  Play Faster 

This button will play back the Live Camera feed or Video Clip at a faster speed in increments. 

9.2.11  Undock Toolbar 

Using this function, the user is able to ódetachô the Playback Toolbar from the Timeline Pane and 

move it around. Once detached, the Toolbar size is increased.  

 

Attached 

 

 
 

Detached 

 

 
 

9.3  Other Controls 

 

There are a couple of other controls in the Timeline Pane that are useful. 

 

1.  Zoom In or Out of Timeline ï Use these buttons to zoom in and out of the timeline. 

2.  Green Center Line - Use this button to center the Timeline. 
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10  Motion Alarm 
 

The Motion Alarm feature in ViewPorts allows the user to configure a Camera so that movement 

in the scene is detected and flagged according to the parameters set by the user. Please note that 

Motion Detection only works with the Low Resolution stream. 

 

10.1  Enabling Motion Alarm 

 

To enable the Motion Alarm: 

 

1.  Open the selected camera that the Motion Alarm is to be set on. 

2.  Right click in the Active Window and select Motion>Enable Alarm. Note that this places 

a red óMô symbol in the selected Camera window and Motion Detection becomes active. 

3.  ViewPorts will now detect and flag any Motion detected in the scene. 

4.  To enable the Motion Alarm on all cameras, right click and select Motion>Enable Alarm 

All.  

5.  To disable the Motion Alarm on all cameras, right click and select Motion>Disable 

Alarm All. 

6.  Configure the Motion Alarm parameters using the Motion Alarm Tab under ViewPorts 

Settings as well as the Motion Detection Tab under the Camera configuration. 

10.2  Motion Masking 

 

Motion masking allows the user to ñmaskò or hide certain areas of the screen from Detection. 

You might do this if the scene is a road with trees on a windy day for example. When Motion is 

detected across the whole camera, the movement of the trees will give false readings, whereas 

the road surface will remain static until such time as a car or other object crosses it. 

 

To enable Motion Masking: 

 

1.  Open the selected camera that the Motion Alarm is to be set on. 

2.  Right click in the Active Window and select Motion>Enable Alarm. Note that this places 

a red óMô symbol in the selected Camera window and Motion Detection becomes active. 

3.  Right click in the Active Window once more and select Motion Mask. This will open a 

dialog box as shown below: 

 

 
 

4.  The Controls in the dialog box can then be used to mask all or specified areas of the 

scene according to the users needs. 
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11   Email 
 

The Email feature in ViewPorts allows the user to instantly sent an email snapshot of a camera 

view or clip to any other Email address. 

11.1  Configure Email 

 

In order to use the Email feature, Viewports must first be configured correctly. Note that there 

are no settings that need to configured on the server running Video Commander, all 

configuration takes place on the clients machine. 

 

Navigate to Tools>Viewport Settings and select the Email tab. On this screen you are able to 

select whether you wish to email clips in WMV format and it is recommended that this default 

setting is left as it is. Select the Configure button and note the Email Configuration screen that 

appears: 
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Enter the necessary Server and Email details as supplied by your Administrator. It is a good idea 

to use the óTestô button to determine if the configuration has been set up correctly 

 

12 URL Access to Cameras 
 

Users of Viewports are able to access the Live Camera streams through a web browser (Firefox, 

Safari and Internet Explorer are supported), providing they have the IP address of the server in 

question and the Server is currently active. This feature is useful if the user does not have 

Viewports installed on their machine, but they still wish to view camera streams. 

 

12.1  Access through Firefox 

 

1.  Launch Firefox. 

2.  In the address bar, enter the Server IP address. 

3.  The user will be prompted for their username and password in order to access the server: 
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4.  Once their details are entered, the user will be at a homepage which lists all the available 

streams (both Low and High Resolution streams can be viewed). Connect to one of the 

available streams in order to view a Live Camera. 

5.  The Live Camera feed will not refresh automatically until the Refresh button is pressed 

once. Press the Refresh button to enable Live Camera streaming. 

6.  To return to the Homepage, hit the Back button and to exit the web browser, close the 

page as you would any other web page. 

12.2  Access through Safari 

 

1.  Launch Safari. 

2.  In the address bar, enter the Server IP address. 

3.  The user will be prompted for their username and password in order to access the server: 

 

 
 

4.  Once their details are entered, the user will be at a homepage which lists all the available 

streams (both Low and High Resolution streams can be viewed). Connect to one of the 

available streams in order to view a Live Camera. 

 

 




